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Important User Information

Please read and follow all safety information for the Parker Automation Controller [PAC), including the

warning and caution statements in this guide, before installing or operating the system.

Safety Information

A\

A\

A\

A\

WARNING:

WARNING:

WARNING:

WARNING:

The PAC is used to control electrical and mechanical components of
motion control systems in industrial environments. To avoid serious
injury or damage to equipment, test the motion system for safety under
all potential conditions.

The PAC and PAC Input\Output (PACIO) Modules are not fault-tolerant
and are not designed or intended for any use in any systems, machines,
or applications where failure or fault of any kind of the Products could
reasonably be seen to lead to death or serious bodily injury of any
person, or to severe physical or environmental damage (“High Risk
Use”). You are not permitted to use, distribute, or sublicense the use of
these Products in High Risk Use. High Risk Use is STRICTLY PROHIBITED.

The PAC contains no user-serviceable parts. To avoid personal injury or
damage to the product, do not attempt to open the case or to replace any
internal component of the PAC, Modules, or accessories.

USER RESPONSIBILITY- Failure or improper selection or improper use
of the products described herein or related items can cause death,
personal injury and property damage.
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About this Project

The project is intended for first time users of the PAC who have some familiarity with the Parker Automation Manager
(PAM] integrated development environment (IDE).

Project BOM
PAC320-CXN31-3A Runtime 3.5.5.20
Compax3 Drive - S025VZ2F12131T11M00 or Parker P-Drives
MPE Motors - MPEO401-KCN
PACI0-450-03
Parker Automation Manager 1.2.1 and 1.2.1 Flashback
Motion_In_Minutes.projectarchive

Expected Programming Level and Project State

The project is intended for first time users of the PAC who have some familiarity with the Parker Automation Manager
(PAM] integrated development environment (IDE).

This project will start from scratch, but Motion_In_Minutes.projectarchive has the solution for both the simulation mode
and online mode.

Users must have familiarity with and understand the purpose of:

e The PAM Device Tree and it's sub components, specifically:
o Task Configurator
o Applications
o EtherCAT_Master
= EtherCAT_Master.EtherCAT Task
o Library Manager

If this is your first time using PAM, please consider reviewing the “Understanding the PAM Environment” tutorial first
which covers these topics.



Motion in Minutes

Creating a New Project

1. Launch Parker Automation Manager (PAM) . Don’t have PAM?

No worries, PAM is available for download on our website,
parker.com/emn or bity.ly/Parker_PAC to go directly to the
product page.

2. Select "New Project...”

5] Start Page x

=) Parker Automation Manager \

Basic Operations

] New Project...
[& Open Project...
m Open Project from PLC...

3. Name your project, we used “Motion_in_Minutes”.

2] New Project [ %= |
Categories: Templates:
E Libraries b b
=3 Parker 'E 'E

3 Pump Empty project  Standard Standard
project project w...

[ Hydraulics
| 3 Winder
[ Projects

An empty project

Name: Motion_in_Minutes

Location:  C:\Users\Public\Documents\Parker Hannifin\Parker Automation Manager'\Projects E]

4. Select "Empty project” and hit "0k”

Setting up your PAM Environment

If you a first time PAM user, we recommend having both the Device and POUs window visible. It is also helpful to have them
stacked on top of another to enable easy click-and-drag functionality between them. We'll be using this functionality later in
this walk-through guide.

To make sure these windows are visible to go “View -> Devices” and “View -> POUs".

You can click and drag the windows to “snap” them into whatever placement you prefer. The Tac icon in the upper left hand
toggles the window between Visible and Auto-hide modes.

Below is an example of the recommended first-time user layout:




5.

6.

Devices

-

‘5 Motion_in_Miutes

-

POUs
=15 Motior_in_Mrutes
G‘ Project Settings

Since the user wants to program the PAC it needs to first be added into the system, right click the project and

select “Add device”

2

Properties...

Add Object
Add Folder...

Add ice...
| Dy

g
Edit Object

Edit IO mapping

Edit Object With...

Device Configuration »

Ty
]

A new window will pop up allowing users to select both the vendor and pre-loaded product types.

[ Add Device - -9
Mame: PAC320_CXX2X_XX
Action:
@ Append device Insert device Plug device Update device
i Device:
Vendor: ’Parker Hannifin
Mame Vendor Version
~ [ ac3o Parker Hannifin ~ 1.7.1.2
Bl | PAC320-000@N-X0) Parker Hannifin ~ 3.5.5.21
Ll PAC320-MXXZX- o* Parker Hannifin ~ 3.5.5.21
-l PACI20-PIOEH-XX Parker Hannifin 3.5.5.21

7. Select the PAC model that matches what you intend to program.

8.

No devices needed for development

This tutorial first covers how to work with physical devices available to the user. The last section of this tutorial discusses how to use the

same program in Simulation Mode.

The device tree will automatically populate with pre-made tasks and hardware configuration menus that are

necessary for configuring and programming the PAC.
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Devices > 0 X
=15 Motion_in_Minutes (=]
= Ell PAC320_O002_ 0 (PAC320-CHX2Y-XX)
=&l PLC Logic

= n' Application
m Library Manager
B8 symbal configuration
= @ Task Configuration
=gk EtherCAT_Master
] EtherCAT Master.EtherCAT Task
2 SoftMotion General Axis Pool
= ﬂj EtherCAT_Master (FAC320 EtherCAT Master)
m PAC320_BusCoupler (PAC320 BusCoupler)

9. Double click on PAC320_CXX2X_XX [PAC320-CXX2X-XX]. Several canfiguration menus and settings are provided
here. Several of these tabs will be used later in the demo to set up our connection and other preferences.
10. Right click “Motion_in_Minutes.” In the POUs windows. Select “Add Object” then “POU”

Device Configuration  »

Library Manager...

POL... x|

POUs > 0 X
=12} | Motion_i Aieesbee—— =]
[} Projed Properties...
|ﬁ Add Object ' | @ CNC program...
) Add Folder... g4 CONC settings...
Add Device. .. %l puT...
Edit Object External File...
Edit Object With... “ Global Variable List. ..
Edit IO mapping Image Pool...
=0 Interface...
(i)
&

What is a POU?

POU stands for Programmable Organizational Unit. This can include, programs, function blocks, and functions. Each of these can be
implemented in one of the several IEC 61131-3 supported languages: Structured Text (ST), Continuous Function Chart (CFC), Ladder (LD,
FBD (Function Block Diagram], IL (Instruction List), and Sequential Function Chart (SFC).

Each language has its own benefits and some work for certain programming functions better than others. For instance, SFC is typically used
for creating state machines or where sequential programming is required, ST is perfect for recipe or data management or where math is
required.

We chose CFC for programming this demo as it is a very visible language, some compare it to LabView. It is easy to debug as one can clearly
see the overall function of the system without needing to know how to program, making it perfect for maintenance-level personnel. It is very
easy to debug as it's clear what “inputs” are needed to provide a specific “output.” Many prefer to do aspects motion programming in this
language as technicians are often responsible for debugging motor issues and faults.

11. Name your program “Basic_Jog” and then select "Add".



" Add POU X"

@ Create a new POU (Program Organization Unit)

Name:

Basic_Jog|

12. A new window will appear asking the user to select the type of program. Select “"CFC - Continuous Function
Chart”.

Implementation language:
Continuous Function Chart {CFC) v|

" Add POU -

@ Create a new POU {Program Organization Unit)

MName:

Basic_Jog|

13. Click and drag the Basig_Jog program under the EtherCAT_Master task

=5 EtherCAT_Master
] EtherCAT Master.EtherCAT Task
@ Basic_Jog

" SoftMotion General Axis #ol

POUs
=) Mosor_lb_Miutes [~
Basic_Jog (PRG)
[} Project Settings

* Note that the POUs and Device Tree are separate. This Basic_Jog program is not apart of the Task, thus
not a part of the application. This means that upon downloading the project to the controller, this
program would not be apart of that download.

By clicking and dragging it under the EhterCAT_Master task we are making a reference to the
Basic_Jog program and will be included upon download.

The major benefits of organizing this way is that if you had multiple devices referencing the same
program, function, etc a programmer would only need to edit it in one place in order for those changes
to be made globally.



Remember!

14. 1f you right click the PAC320-BusCoupler select “Add Device” | EtherCAT Master [PAC320 EtherCAT Master] acts as a
representation of the actual RJ-45 EtherCAT port. Whereas

the List will automatically populate with all the PACIO modules | the PAC320_BusCoupler (PAC320 BusCoupler] is a

currently available (assuming you're using the latest version representation of anything connected to the E-bus
connector such as PACIO.

of PAM).
[ Add Device XS

Name: PACIO_DIle_DOl1g

Action:

@ Append device

Device:

Vendor: [Parker Hannifin h

Mame Vender Version Sl

ﬁ Al4-m& (PACIO-441-01) Parker Hannifin Revision=16#00000003
m AT4-PHNi100 (PACIO-443-01) Farker Hannifin Revision=16500000002
m AI4-Pt/Ni1000 (PACIO-443-03) Parker Hannifin Revision=16500000002 =
m AT48-VDC (PACIO-441-02) Parker Hannifin Revision=16£00000002
m AQ4VDC/mA 12 Bit (PACIO-442-02) Parker Hannifin Revision=16500000002 R
ﬁ Counter/Enc 5V (PACIO-454-01) Parker Hannifin Revision=16#00000003
@ DI16 1ms (PACIO-451-03) Parker Hannifin Revision=16#00000001
m DI16/D0O16 1ms 0.54 (PACIO-450-03) Parker Hannifin Revision=1600000001

15. Add the PACIO attached to your unit by selecting the part number and clicking "Add Device.” In this demo we used
PACIO_DI16_D016 as it will be used in our program later. (We'll go into how to use the “Scan” function later on
which makes adding PACIO even easier.]

16. Lastly, right click "EtherCAT_Master (PAC320 EtherCAT Master]” and select “Add Device”. A new window will open
and a list will fully populate with all the EtherCAT slaves currently supported by Parker:
P

[ Add Device

MName: Compax3_EtherCat_D3402_CoE_
Action:
@ Append device

Device:

Vendor: [Parker Hannifin ']
Marne Ver *
[l Buscoupler (PACIO-400-00) Pari|
ﬂi C3S00VxPXxI31T11Mx0c_ OpModens V2,05 Encoder SoftMotion Parl
ﬂi C3%00cxFocl31T11M0_OpModels V2.05 SoftMotion Parl

Adding a Compax3
17. If you have a P-drive skip to Step 20
18. Select "C3SxxxVxFxxI31T11Mxx_0pMode08 V2.05 Softmotion” and Add Device. This is representative of the

Compax3 Drive.
19. After adding the appropriate devices in your system, your device tree should be similar to the one listed below:



=g Metion_in_Minutes
= Fl PAC320_CXX2X_X (PAC320-0X0X2X-XX)
=2 PLC Logic
=1} Application
m Library Manager
B8 Symbol configuration
= @ Task Configuration
=g EtherCAT_Master
B EtherCAT_Master EtherCAT Task
@ Basic_Jog
"2 SoftMotion General Axis Pool
= ﬂj EtherCAT_Master (PAC320 EtherCAT Master)
= m PAC320_BusCoupler (FAC320 BusCoupler)
ﬂj PACIO_AO4_VDC_mA (AO4 VDC/mA 12 Bit (PACIO-442-02))
[l PaCIO_DI16_DO16 (DI16/DO16 ms 0.54 (PACIO-450-03))
= m Compax3_EtherCat_D5402_CoE_ (C3SmaxFiuxI 31T 11Mxx_OpModel
L¥ SM_Drive_ETC_PARKER (5M_Drive_ETC_PARKER)

Adding a P-drive
20. Select "PD-xxC - Standard EtherCAT Drive (CoE EoE,FoE)" and Add Device. This is representative of the P-drive.
21. Close out of the "Add Device” window.
22. Right click the newly created "PD_xxxC_Standard_EtherCAT drive) and select "Add SoftMotion CiA402 Axis”
23. After adding the appropriate devices in your system, your device tree should be similar to the one listed below:

=@l PAC320_PDrive (PAC320-CXX2X-XX)
+-E pLC Logic
. SoftMotion General Axis Pool
= ﬁj EtherCAT_Master (FPAC320 EtherCAT Master)
= ﬁ PAC320_BusCoupler (PAC320 BusCoupler)
[ Pacio_DIi6_DO16 (DI16/DO16 ims 0,54 (PACIO-450-03))
= ﬁ PD_xxC_Standard_FtherCAT_drive (PD-xxC - Standard EtherCAT driw
ﬁ? SM_Drive_ETC_GenericDSP402 (SM_Drive_ETC_GenericDSP402)

Writing the Program

In this program we’ll create a basic jog controlled by the digital inputs of PACIO_DI16_D016.

1. First, let's rename our motaor axis so it's easier to call in our Refactoring?
program, slow double click “SM Drive ETC Parker..” and Refactorlng scans all programs and‘dependen‘ues that.use
.o ) ) ) ; the changing variable and renames it automatically. This
rename "X". A new window will pop up asking if you want to makes it so users don't have to manually comb the
Refactor. program and make the changes yourself.

2. Select "Yes". The PAC will indicate all areas where the name was changed. In this case we only are using it in one

place:



Refactoring . I ; N e e

Rename 'PAC320_CXX2X_XX.EtherCAT_Master.Compax3_EtherCat_DS5402_CoE_.SM_Drive_ETC_PARKER' to 'X'. 2pply all changes.
Basic_Jog Mame Type Value Variable Address
=-Ell PAC320_0XX2X XX #--[dl AXIS_REF: Standard
+-El PLCLogic + -l AXIS_REF: Scalings
"3 SoftMotion General Axis Pool +-[0 XIS REF: DSP402configuration
= ﬂi EtherCAT_Master +-[ 1 possible cyclic driver in-foutputs
+- [ Pac320_BusCoupler ¥ IEC Object AXIS_REF_ETC_PARKER X
=[] Compax3_EtherCat_DS402 CoE_
CHF x

G’ Project Settings

oK ] [ Cancel

3. Select "OK".
Double click “PACIO_DI16_D016" Select the EtherCAT 1/0 Mapping tab.
5. This is where we will tie our inputs to specific variable names to use them in our program. Use the following

names:

Channel Variable Program Purpose
Digitallnput0 di_Enable Enables the drive/motor
Digitalinput1 di_JogPos Input will jog the motor in the positive direction
Digitallnput2 di_JogNeg Input will jog the motor in the reverse direction
Compax3_EtherCat_DS402_CoE_ [l PAC320_CXX2X_XX ] racio_p1i6_C
| Slave | Process Data | ™ EtherCAT 1O Mapping | status | @ Information |
Channels
Variable Mapping  Channel Address Type
Fio Digital Qutput1s %X 13.7 BIT
“ di_Enable - CigitalInputd %30 BIT
4 di_JogPos @ DigitalInputl %el¥3.1 BIT
* di_Jogheg & DigitalInput2 BelX3. 2 BIT
4 DigitalInput3 %olX3.3 BIT
gy MinitalTanoka oF TVD A RTT

Device names and 1/0 variables are GLOBAL. This means that we do not need to declare them as we
begin programming below. If we did—these local variables would override the 1/0 variables and our
program would not be able to utilize the digital inputs.

6. Open up the Basic_Jog program by double click on it. (Remember, you must do this from the POU window as the
Jog_Basic under our EtherCAT_Master task is just a referencel)

7. This will open up a programming space.



8. From the newly-opened Toolbox window, Click and drag a Box into the programmable field:

EtherCAT_Master

v

Compax3_EtherCat_DS402_CoE_

T Basic_log x [ [7]

PROGRAM Basic_Jog

{'f{ Pacsncw

ToolBox ~
= CFC

] & Pointer

Scope

Neme  Address  Datatype Initialization ~ Comment

[0

Attributes

*l Contral Point
= Input

= Output

B Box

= Jump

= Label

= Return

9 Composer

T Selector

= Comment

== Connection Mark - Source
== Connection Mark - Sink
IF Input Pin

v

o

47F Output Pin

9. Go ahead and start typing "MC_" a box will automatically pop up with matching functions. Nothing should “MC_..."

|

=]

Md ("0
@ [MAX
& MIN

& MOD
& MOVE
< MUL
& MUX
& NE

@ NOT
& OR

&

REAL_TO_BOOL

£

10. The reason is that our program has no libraries that it's referencing. Copy and paste the “Library Manager” from

the “Application” to our POU tree:

E 151 Motion_in_Miutes

m] Library Manager

Basic_Jog (PRG)

E}' Project Settings

11. Now re-type "MC_J" note many motion related functions are automatically recommended helping the

programmer. In this case select "MC_Jag".

MC_CamlIn
MC_CamQut
MC_CamTableSelect
MC_DigitalCamSwitch
MC_Gearln
MC_GearInPos
MC_GearQut
MC_Halt

Still not working?

If you're working from a fresh install of PAM you may not have the correct auto-complete settings enabled.

From the file menu go to “Tools” -> “Options” In the options window go to “SmartCoding”. Be sure that every item under SmartCoding is

checked and click “0OK". Try again.




12. The box will transform into the MC_Jog function with required function block inputs and outputs with small leads,
shown as lines, used to connect it to other function blocks or variables, etc.:

T -
(o]

s Busy—
—JogForward Commandfborted —
—JogBackward Error—
—Welocity Errorld —
—&cceleration

—Deceleration

—{Jerk

13. Slow double click on the ??? and name our function block “JogX". Since this variable has not yet been declared, a

new Auto Declare window will appear asking to declare the variable. Select “OK”

Auto Declare %
Scope: Name: Type:
VAR | Jogx MC_Jog v
Object: Initialization: Address:
=
Flags: Comment:
[F] consTaNT B
[T RETAIN
[] PERSISTENT ~
14. The variable now populates on the variable list:
Basic_Jog_1 X =
1 PROGRAM Basic_Jog - E
-z VAR i
3 Jog¥: MC_Jog: = I:I
s END VAR
4 m | »
Fa
=
Jog)( )
MC_Jog —
BEixis Busy—
—JogForward CommandAborted —
—JogBackward Error—
—{Welocity Errorld—
—|Acceleration
—Deceleration
—jderk
15. Click and add another box to the programming window. Instead of manually typing "MC_..." select the “..." next to
the “77?" text box.

16. This offers an alternative way to find function. You'll note the same libraries in our Library Manager is listed. Open

the Categories Tab and open the tree:



“Function Blocks” -> "SM3_Basic” -> “POUs" -> "PLCopen” -> “single-axis function blocks” -> “Part I" and select
“‘MC_Power”

The documentation window automatically populate information based upon the selected function block helping the
users determine what function block is needed to solve their application.

Functionblocks o Name Type
Module Calls = 3 pLcopen

Instance Calls #- I additiona

Keywords ®- 2 internal

Conversion Operators 2 master/slave function blods

= I20 single-axs function blods
=-Pat1

MC_AccelerationProfile
MC_Halt
MC_Home
MC_MoveAbsolute
MC_MoveAdditive
MC_MoveRelative
MC_MoveSuperImposed

* MC_MoveVelocity
MC_PositionProfile

MC_Power
Structured view
Insert with arg

ocumentation:

FUNCTION_BLOCK MC_Power

|Axis AXIS_REF_SM3 [VAR_IN_OUT

Enable BOOL VAR_INPUT

bRegulatorOn BOOL VAR_INPUT

bDriveStart BOOL VAR_INPUT

Status BOOL VAR_QUTPUT Axis ready for motion

bRegulatorRealState BOOL VAR_OUTPUT [Effective state of the power stage

bDriveStartRealState BOOL VAR_OUTPUT |drive not blocked (no quickstop)

Busy BOOL VAR_OUTRUT

Error BOOL VAR_OUTPUT |Signals that Error hasoccured within Function block

ErrorD SMC_ERROR  [VAR_OUTPUT [Error Number

17. Select OK and the function block will be added to our program. Name it “"MC_Power0" and allow the program to
auto declare it.

18. Click and drag an input to the program and slow-click in the text box and name it “X". Click and drag the lead from
“X" to the "Axis” leadoff MC_Power0.

MC_Powerl ()
MC_Power =
Lxis Status -
Enable bRegulatorRealState —
bRegulatorOn bOnveStartReal State -
bDOrveStart Busy—
Error—
ErrorlD

This selects the "X axis, or rather, the motor connected to the Compax3 is the motor that will be controlled by this
function block. NO NEED TO DECLARE “X"I Like our I/0, it's already a “global variable” that is tied to the motor
either on our Compax or P-Drive.

19. Complete the rest of the function block as shown below:



MC_Power0 '

MC_Power —
* i Status —
True Enable bRegulatorRealState —
di_Enable I—[ bRegulatorCin bOnveStartReal State —
bOrivestart Busy—
Error—
ErrorlD -

20. The JogX function requires several variables that have not been created yet and are not global. Type “"JogAccel:

LREAL := 10;"inthe variable window above your program:
1 PROGRAM Basic Jog
z WAR
3 JogX: MC Jogr
4 MC Power(0:MC_Power:
5 Joghcecel: LEEAL := 10;
€  END VAR

21. Alternatively, variables can also be entered in using a tabular format. Use the "Tabular” button in the upper right
corner of the variable window to expose this option.

Basic_Jog_1 X -

1 FROGRAM Basic Jog

- Z WAR
3 JogX: MC Jog;
4 MC Power(:MC Power:
5 Joghceocel: LEEAL := 107
& END VAR

a4 | 1 [ ¥

PR

22. To create a new variable, select the “Insert” button in the variable list above the program window.

< W > PROGRAM Basic_Jog

Scope Mame Address Data type Initialization
1 @ VAR  JogX MC_Jog
2 @ VAR MC_PowerD MC_Power
3 @ VAR JogAccel LREAL 10

23. Name the new variable “JogVel” and set the initial value to 5. Change the input type to an “"LREAL" or a long real.

(v PROGRAM Basic_Jog
-~
Scope Mame Address Data type Initializaticn
1| & vAR  JogX MC_Jog
Z @ VAR MC_PowerD MC_Power
3l & vAR  JogVel LREAL 5

24. For the last variable we'll use one more method of declaration. Click and drag an input onto the program. Start
typing the desired variable name, in this case, “JogDecel” after pressing enter, an Auto Declare box will open.



Auto Declare e

Scope: Name: Type:

[var | logDecel NT - [
Object: Initialization: Address:

| Basic_Jog - | _

25. Set the data type to LREAL with the initial value of 10.
26. With your newly minted declarations, complete the program. IT should look like the following function blocks
below:

MC_Powerl
MC_Power
X xis Status
True Enable bRegulatorRealState
di_Enable bRegulatorOn bDriveStartRealState
bCiriveStart Busy|
Error
ErrorlD
JogX o
MC_Jog —
}(—Ii"’ Lis Busy—
di_JogPos JogForward CommandAborted —
di_JogNeg JogBackward Errar—
JogVel F———velocity Errorld—
Joghccel LAcceleration
JogDecel Dieceleration
—lerk

* REMEMBER, Device names and 1/0 variables are GLOBAL. Do NOT declare X, di_JogPos, di_JogNeg,
di_Enable in your program.

Don’t have an I/0 Module?
THEN you’ll want to declare di_Enable, di_JogPos, and di_JogNeg as BOOL. In this case we’ll
“force” these variables (as shown in “Simulation Mode” pg. 16-19.) No need to jump to this step yet.



Important Configuration Settings

Configure the EtherCAT_Master Task

1. Inthe Devices tree, double click the PLC Logic-> Application-> Task Configuration -> EtherCAT_Master node to

bring up the Task Configuration dialog.

2. Inthe Configuration dialog, change the Type to be External and the External event to be EVENT_ECM_DC. Ensure

that the Priority is set to 0.

& EtherCAT_Master X}/m Device rrﬁ EtherCAT_Master

Configuration

Priority { 0.31 )z 0

Type
External event: |EVENT_ECM_DC

What are we doing here?

Interval (e.g. t#200ms): 2000

In theory, our project can run using one of two clocks, either the clock in the real time operating system OR a higher precision external clock
(sometimes referred to as a boundary clock]. Because of the precision required for EtherCAT and especially motion control applications, the
external clock should always be used. Priority 0 puts this task as the “highest priority task and cannot be interrupted by other tasks or events. Thus,

all our motion critical and high precision tasks should be here.

Protip: Don’t set the update interval value here. It's better to do it in the EtherCAT_Master (PAC320 EtherCAT Master) settings. The reason is that
the EtherCAT_Master (PAC320 EtherCAT Master] interval setting automatically changes the interval setting here—and they must match.

Configure EtherCAT_Master Node

3. Inthe Devices tree, double click the EtherCAT_Master node to bring up the EtherCAT_Master Configuration

dialog.
4. Ensure that the Autoconfig Master/Slave checkbox is checked.

5. Change the Distributed Clock Cycletime to the EtherCAT cycle time that
you wish to achieve. (2000 usec in this example).

6. The rest of the settings can be left to default.

Distributed Clock

Cycletime 2000 = ps
Sync Offset 20 =
|:| Sync Window Maonitoring

Sync window 1 “| ps

Configure PLC Settings

Cycle time is limited by slaves

For an EtherCAT network that includes a
Compax3, the Distributed Clock Cycletime
should not be lower than 500 usec and must
be a multiple of 250 usec. A Distributed
Clock Cycletime of 1000 usec is a
reasonable starting point.

7. Double click on the PAC320_CXX2X_XX [PAC320_CXX2X_XX). Select the “PLC Settings” Tab.

8. Check "Update 10 while in stop”

9. Change "Always update variables” to "Enabled 2 [always in bus cycle task]

PLC settings
Update IO while in stop

Behaviour for outputs in Stop: [K,eep current values

Always update variables:

lEnabIed 2 (always in bus cyde task)




How will these settings change the behavior of the PLC?
Although a preference, some users expect to see the |0 update even with the PLC is in “stop” mode. For instance, this may help

the user manually test if the inputs are wired up correctly by toggling them manually and seeing them change in the watch
window. To ensure this behavior select “Update 10 while in stop”.

Typically it is undesirable to have all variables update every bus cycle as not all variables are in use at the same time. However,
since the program we're writing has so few variables, the EtherCAT cycle will not be bogged down by selecting this option.
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Setting up a Connection

Preparing your PCs Network Settings

In order to connect with the PAC, the PC used for programming needs to have a static IP set up on their Ethernet port. The default
static IP address of the PAC is 192.168.10.50 with a subnet of 255.255.0.0 The Ethernet port used to connect to the PAC needs to be in
the same subnet, for example:

_

N
[ Local Area Connection Properties P Internet Protocol Version 4 (TCP/IPvS) Properties ? B
Networking | Sharing General
Connect using: ‘You can get IP settings assigned automatically if your netwark supports
) this capability, Otherwise, you need to ask your network administrator
LF Intel(R) Ethemet Connection (3) 1218V for the appropriate IP settings.
() Obtain an IP address automatically
This connection uses the following tems: @) Use the following TP address:
lq. . . :
9% Client for Microsoft Networks 1P address: 192 188 . 10 . 10
o] /GN Filter Interface (LWF)
=1 105 Packet Scheduler subnet mask: 255,255, 0 . O
] Q File and Printer Sharing for Microsoft Networks Default gateway:
i Intemet Protocol Version & (TCP/IPvE)
-4 |ntemet Protocol Version 4 (TCP/1Pv4)
Fildmim FRIC mme e e mmm = b = bl

1. Double click on “Device [PAC320-MXX2X-XX].” Under the Communications Settings tab, select Scan Network.

ConTmunicah'on Settings |Applimﬁons | Files | Log I PLC settings | PLC shell | Users and Groups | Access Rights | Task deployment I

Scan network... | Gateway » Device -

[ ] .
Gateway .

- EMNODSUDM 176821 -

2. After the scanning pracess finds the PAC, select the PAC and click OK.

Select the network path to the controller:
= -#g. Gateway-1(scanning...)
m |PACDD].DE§DDDE|27 [0144.4000.0432]

Device Name:
| PAC001053000027

Device Address:
014A.ADOD.DA3Z

Target Version:
3.5.4.0

Target Vendor:
Parker Hannifin

| can’t find my PAC...
If you know the IP Address of your PAC you can type it in directly type it into the connection box.

Gateway

fateway-i] - EMMODSUDM 176821 -

If you still cannot connect to the PAC, confirm that you can “PING” it using the Windows Command Prompt.

If you cannot receive replies form the PAC it may mean that either your Network Settings, your IT department, administration
settings, or firewall are preventing connection.




Lastly, the IP address of the PAC may not be what you expect. You can determine the IP address of the PAC by reading it form the
SD card. Full instructions on how to do this are in the user manual.

3. The Green dot on the device indicates that the device was found and you are now connected to the PAC.

| Deviee x|

Communication Settings | Applications | Files | Log | PLE settings | PLC shell | Users and Groups | Access Rights | Task deployment |

Scan network... | Gateway v Device -

® .
Gateway .
- [D144.AD00.0437] {active) -
IP-Address: Device Name:
localhost PAC001053000027
Port: Device Address:
1217 014A.A000.0432

Scanning and Comparing EtherCAT Devices

1. Inthe Devices tree, right-click the EtherCAT_Master (PAC320 EtherCAT Master] node and select Scan For
Devices... This scans for all devices specifically on the EtherCAT port including PACIQ, drives, or other EtherCAT

devices.
— T —
|
Fle Edt Vew Project Buld Onine Debug Tools Window Hep
e B8 A - YA
= 3 Project] | :{
= PAC320_MXOQX_XX (PAC320-MXX2X-XX) g Maste
= B PLC Logc 7
= © Apphcation

@ Ubrary Manager et
= [# Task Configuration
= & EtherCAT_Master De
8] EtherCAT_Master.EtherCAT_Task so
‘3 SoftMotion General Axis Pool
: 1

T
= [ PAC320_BusCoupler (PAC320 BusCoupler) | & Cut
@ PACIO_AI4_mA (Al4-mA (PACIO-441-01] gy Copy
@ PACIO_DI16_DO16 (DI16/DO16 1ms 0.4
@ pacio_o32 (0132 m(pﬁao-zsx-oz);ﬂ Paste b
@ Compax3_EtherCat_DS402_CoE_ (C3Sxxx X Delete g

‘ﬁa Properties...

) Add Folder... ?
Add Device...

[ Scan For Devices...
Disable Device
[ Edtt Object

o Edt Object Weh... X

2. A"Scan Devices” dialog box will open showing all the devices available on the EtherCAT network.

My Scan Isn’t Working
If the first connection since a flash back or connecting to the PAC for the first time you must first login before proceeding with scanning. This is due to
the PAC not yet being programmed with the EtherCAT master configuration—this occurs on the first download.

3. Inthe lower right hand corner, select the “show differences in project”. Differences between the devices listed in
the project and what actual devices are on the network show up in red.
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Scanned devices Corfigured devices
Devicename Devicetype Ali Devicename Devicetyp
=i PAC320_BusCoupler PAC320 BusCoupler 1 C E = PAC320_BusCoupler
i PACIO_DITE DOTE | DVT&DOTS Ims 0.54 (PACIO-450-03) | 0 | b PACIO ADL
: = Compaxd EtherCat DSI02 Cok
=B e X SM_Drive |
Copy all
Del
] il 3 ] [ 3
show differences to project

4. If you have added all your devices correctly the whole list would appear as green. For this example a
PACIO_DI16_D016 and Compax3 EtherCAT drive were used.

Devicename Devicetype

=i PAC320_BusCoupler PAC320 BusCoupler
- PACIO_DIe_DO1& DN&/D016 Ims 0.54 (PACIO-450-03)

= Compaxd EfherCat DS402 Cof | C35oolaFxxiZ1T7 1My OpModaldl 1205 5
- X S Orive ETC PARKER

That’s easier! Why didn’t we just scan the 1/0 in the first place?
Previously we had manually added the I/0 and Compax3 manually to our project. If you have a system that is already fully connected this
step is unnecessary as you can simply Scan them in. The benefit of adding on modules manually is that one can begin programming

before hardware has arrived.




Running the Demo

1. To download the project execution code, select the Login Icon on the Toolbar.

A Y ) mli=5=="=3]=|%

Y (i Device x|

g Communication Settings

2. You may be prompted to find an active path. To have the PAC automatically scan, select Yes. To open the
Communications Settings Page, select No and then proceed to scan the network for the PAC.

i T =)

— -

@ Mo active path defined. Do you want to set it?

Clicking "Yes' will start a network scan on the 'Communication Settings’
page. If there is a device found with the same name and address you
used last time, the active path will be set to it.

Clicking ‘Mo’ will just show the 'Communication Settings' page without
any action,

Clicking 'Cancel' will return without deing any action.

3. Ifthere is a project already on the PAC and you want to replace it with this application, click Yes.

4. Ifyou are downloading the project the first time to a PAC without a project, it may prompt you with a pop up
window asking if you want to download the application, click Yes. The project is now downloaded to the PAC.

4102

TargetVendor:
Parker Hannifin

TargetVersion:
3.54.0



5. Lastly, if there are any errors in your program, they will be populated in the messages window. (Go to View -»
Messages to open up this window]

Messages - Totally 0 error(s), 1 warning(s), 5 message(s)
Build ~ || 0 error(s) | % 0 warning(s) |€¥ 5 message(s) | b4

Description

------ Build started: Application: PAC320_C0@¥_Application —--——-
typify code ...
generate code...
generate global initializations ...
generate code initialization ...
generate relocations ..
& Size of generated code: 589820 bytes
# Size of global data: 169559 bytes
& Total allocated memory size for code and data: 734224 bytes
@ Memory area 0 contains Data, Input, Output, Memory and Code: size: 954491 bytes , highest used address: 734224, 1.
& Memory area 1 contains Retain Data and Persistent Data: largest contiguous memory gap: 262120 bytes (100 %)
Build complete —- 0 errors, 0 warnings : ready for download!

Press Start or use F5 as a short cut key to run the program.

7. If you have toggle switches hooked up to your demao, you are now able to control the motor with these inputs.
Enable by toggling input 0, jog forward by toggling input 1 and reverse by toggling input 2.

8. If you do not have I/0—see Simulation Mode Steps 16-19 to obtain motion.



Simulation Mode

1. First, copy and paste a your PAC320-C device under the Motion_in_Minutes Root.

=13 Mption_in_Miwtes
+ il PAC320_CXXZY_XX (PAC3I20-CXXZX-XX)
+ -l PAC320_CXX2ZX_XX_1 (PAC320-CXX2X-XX)

2. Slow-click to rename the copied device to "PAC320_C_Simulation”. This will help to identify which device is being
run in simulation mode and which utilizes actual devices on the bus.
3. Right click "PAC320_C_Simulation” and select “"Upgrade Device”.

[ Update Device &J
T W 3 -
Name: |PAC320_C_Simulation
Action:
(™) Append device @ Update device
Device:
Vendor: [35 - Smart Software Solutions GmbH A
MName Vendor Version
([ cODESYS Control RTEV3 35 - smart Software Solutions GmbH ~ 3.5.5.20
([ cODESYS Contral RTE V3 64 35 - smart Software Solutions GmbH ~ 3.5.5.20
[{J cODESYS Cantral Win V3 35 - Smart Software Solutions GmbH =~ 3.5.5.20
m CODESYS Control Win V3 64 35 - Smart Software Solutions GmbH ~ 3.5.5.20 |
E CODESYS HMI 35 - Smart Software Solutions GmbH ~ 3.5.5.20
([ coDESYS softMotion RTEV3 35 - smart Software Solutions GmbH ~ 3.5.5.20
[{J cODESYS Softmotion RTEV3 64 35 - Smart Software Solutions GmbH ~ 3.5.5.20
m|CODESY‘S SoftMotion Win V3 35 - Smart Software Solutions GmbH ~ 3.5.5.20
m CODESYS SoftMotion Win V3 64 35 - Smart Software Solutions GmbH ~ 3.5.5.20

4. Specifically select the “CODESYS SoftMotion Win V3". And “Update Device”. Close when the process is completed.
The Device is now renamed to "PAC320_C_Simulation (Codesys SoftMotion Win V3).

5. As thisis a simulation—three is no actual EtherCAT bus to be serviced. Delete the "EtherCAT_Master.
EtherCAT Task” under the EtherCAT Master.

=g EtherCAT_Master

EtherC.
%IE & cut =
tMotion General Axis Cooy
1_C_SimuZ (CODESYS Paste
|}( Delete |
[2 Properties... %
Add Object
3 AddFolder...
[T EditObject
Edit Object With...

6. Continuing that logic—instead of using the external clock, the simulation will use the real-time operating system’s
clock to simulate the PAC. Double click the EtherCAT_Master and change from “external” to cyclic.



Configuration

Priarity { 0..31 ): 0

Type

[Cydic "] Interval {e.g. t£200ms); 20 @

7. The embedded OS clock doesn’t have the same capabilities as the external clock so the cycle time may needs to be
increased. Set it to 20 ms.

8. The EtherCAT_Master [PAC320 EtherCAT Master) has been fully replaced by the “SoftMotion General Axis Pool”.
To add an axis to the simulation device, right click the “SoftMotion General Axis Pool” add the “SM_Drive_Virtual”.

[ Add Device P -

Name:
Action:

@ Append device

Device:

Vendor: (35 - Smart Software Solutions Gmbr

Name Vendor Version
& SMC_FreeEncoder 35- Smart Software Solutions GmbH ~ 3.5.5.0
E SM_Drive_PosControl  35- Smart Software Solutions GmbH ~ 3.5.5.0
& SM_Drive_virtual 35- Smart Software Solutions GmbH ~ 3.5.5.0

9. Once added, rename it “X" so that it is compatible with the Basic_Jog motion program already written.
10. Since no /0 is available our inputs can instead be simulated by forcing variables. Open up the Basic_Jog [PRG) and
declare these additional variables in addition to the already existing ones:

Variable Type Initialization
di_Enable BOOL 0
di_JogPos BOOL 0
di_JogNeg BOOL 0

11. As there can only be one active application per project, right click the simulation mode application and “Set as
Active Application”.

12. To run in simulation mode, PAM needs to process PLC and motion behavior in the background. To do this open
CODESYS SoftMotion Win V3. From Windows -> Start -> Programs menu.

Programs (3)

CODESYS SoftMetion Win{fp
[ CodeMeter Command Protrpt
@ CodeMeter Control Center

Control Panel (3)

L& Set up a dial-up connection

& Change the date, time, or number format

- See more results

code ¥ | | Shut down | » |



13. A new window will execute various code. This window is working with windows in the background to simulate the
PAC. Minimize this window, DO NOT close this window as the simulation cannot function thhout it.

81452486953311 Cmp—CmpRuutex

{instance>1<{/instance’ addre
B1452486958311: Cmp=CmpRouter
{instance>2{/instance’> addre
B1452486958311: Cmp=CmpRouter
<instanceX>3<{sinstance’ addre
B1452486958483: Cmp=0OnlineLicen

License for SoftMotion Basic not installed.

(1452486958545 : Cmp=CmpApp. Clas
n bootproject of application [<
B1452486958546: Cmp=CmpApp. Gl
plication [£app>fApplication{~a
B1452486958548: Cmp=CnpApp. C1
p*Application{sapp>]1 started
B1452486958548: Cmp=CM. Class=1. Error=8,

L

@1452486958603: Cmp=CM, Class =@,
ervice: DEMO mode activated, i
01452486950743 - Cmp—CmpRuutel

1, Error-=8,

- Info=1,
thal8)<{ addm

Info=22,
ion</app>1

Info=6,

Info=18, p
Info=34. pszInfo= CODESYS Control read|

Info=B,. pszInfo=*

ing in approx. 128 m
Evrvor=H,. Info=1.

{instance>3<{ instance’ address to (addless)(3254 BABL < Aadde >

pzzIlnfo= No retain area i

pszlnfo= Setting router
>
Info=8. pszInfo=

Info= Bootproject of ap

zInfo= Application [<ap|

* CODESYS Control %

nf = Setting routep|

14. Go back to PAM. Double click the "PAC320_C_Simulation” to open the Communication Settings. As there is no
actual, physical PAC, change the connection to the name of your computer. This should be populated
automatically. In the authors case, their computer name was "EMNOD5UMT520773." This step can be thought of
as the PAM project connecting to the simulation processing in the background. A green light, like the one shown

below implies that the connection is completed.

EMMODSUMT 520773 (active)

Press ENTER to set active path...

15. Login to the simulation in the same manner as real, physical connection to the PAC. Either select “Start (F5)" to

run the application.

16. Open up the Basic_Jog [PRG) and open the variable declaration table. Both the program and this table are now

“live” showing the current state of all variables.

17. To simulate toggling a switch, click on the “prepared value” table next to di_Enable and di_JogPos to set them to

PAC320_OXX2X_XX_1.Application.Basic_Jog

“true.”

Expression
+ @ MC_Power_0
+ @ MC_Jog_ 0
@ JogVel
@ JoghAccel
@ JogDecel
@ di_JogPos
@ di_JogNeg
@ di_Enable

Type
MC_Power
MC_Jog
LREAL
LREAL
LREAL
BOOL
BOOL
BOOL

Value Prepared value
5

10

10

FALSE

FALSE

FALSE

18. To force these values either go to the File Menu -> Debug -> Force Values or press “F7".
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19. Double click on “X". The Position [u] of the SoftMation Drive: Basic should be increasing, showing our simulation is
jogging in the positive direction.




